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Cubase 10.0.30 

New Feature 

ARA 2 support is now available with this version. This feature can be found under the 
Extensions heading. There are three ways to apply ARA-capable Extensions to an audio 
event: 

- Audio Menu > Extensions > Choose Extensions (e.g. Melodyne) 

- Context Menu on Audio Events > Extensions > Choose Extensions 

- Info Line in project window for selected Audio Events > Extensions > There you 
can either select an Extension, or you can read which Extension is already active 
for the selected event. 

The Extension item only appears if ARA-enabled extensions have been found by Cubase. 
If there is nothing on the system, you won't be able to see it in the menu. 

Issues & Improvements  

Audio Alignment 

In Cubase 10.0.30, the Audio Alignment function is also able to turn the phase of the 
signal by 180° if necessary, to provide clean and steady sound. 

- When applying Audio Alignment with the Prefer Time Shifting option, the inversed 
phase of the target is detected and corrected automatically. The phase inverse is 
applied as a real-time process. 

- The real-time Phase Inverse process can also be applied manually by setting the 
parameter in the Info Line. 

List of resolved issues 

The following list details resolved issues and improvements in this version.  
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ID # Area Issue 

CAN-21994 Audio 
Alignment 

An issue has been resolved where unintentionally applying 
clips to missing media files could render the application 
unreliable.  

CAN-22464 Audio 
Alignment 

An issue has been resolved where Audio Alignment did not 
work correctly on project sample rates other than 44.1 or 
48 kHz. 

CAN-22166 Audio 
Connections 

Improved behavior when assigning multiple busses at once 
using modifier keys in the Audio Connections window.  

CAN-22110 Audio Export 
Window 

An issue has been resolved where selecting disabled items 
in the Audio Export window were still possible with the 
mouse wheel. 

CAN-22488 Audio Export 
Window 

An issue has been resolved where the Export Channel 
option in the Audio Export window was not preselected 
when changing preferences. 

CAN-18473 Automation An issue has been resolved where overwritten Automation 
was read incorrectly when the reduction level was set to 
0%. 

CAN-21850 Automation An issue has been resolved where activating Show Data 
on Tracks in the Automation Panel settings could render 
the application unreliable. 

CAN-16784 Control Room An issue has been resolved where the Mixconvert Center 
level would automatically be set to -¥ when applying the 
Audio Connections Output Channels default preset. 

CAN-16765 Control Room An issue has been resolved where the Control Room area 
would not be displayed correctly when toggling between 
projects. 

CAN-22667 Converting 
Tracks 

An issue has been resolved where converting tracks would 
not result in expected track names. 

CAN-21755 Direct Offline 
Processing 

An issue has been resolved where certain languages could 
be displayed in truncated form when working with the 
Normalize process. 

CAN-21322 Editing An issue has been resolved where the Scrub tool was not 
working correctly when using the editor on a secondary 
screen. 
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CAN-22295 Editing An issue has been resolved where Nudging crossfades in 
the Quantize Panel when using Folder Track Group Editing 
could led to nudging events. 

CAN-22307 Expression 
Maps 

An issue has been resolved where scroll bars in the 
Expression Maps setup window were invisible. 

CAN-5757 Hardware An issue has been resolved where USB MIDI connections 
were not automatically recovered after temporary 
disconnecting a device. 

CAN-18359 Hardware An issue has been resolved where the MIDI Device 
Manager would not automatically reconnect to external 
MIDI ports. 

CAN-22272 Hardware An issue has been resolved where the MIDI Reset 
command could reset faders on external controllers. 

CAN-21860 Metering An issue has been resolved where Input Bus Metering did 
not work correctly when Direct Monitoring was active. 

CAN-18836 MixConsole Improved MixConsole user interface responsiveness when 
expanding the EQ Rack. 

CAN-19005 MixConsole An issue has been resolved where the left zone of the 
MixConsole would reset every time the right zone was 
activated or switched. 

CAN-19367 MixConsole An issue has been resolved where gain reduction meters 
were missing on dynamic modules in the MixConsole 
channel strip user interface. 

CAN-21325 MixConsole An issue has been resolved where combining automation 
of VCA master and slaves could render the application 
unreliable. 

CAN-21408 MixConsole An issue has been resolved where, after copying and 
pasting channel settings, existing pan settings would not 
be included. 

CAN-22167 MixConsole An issue has been resolved where assigning routing for 
multiple channels at once using the SHIFT modifier key 
could render the application unreliable. 

CAN-22364 MixConsole An issue has been resolved where MixConsole Quick Link 
was not working correctly when using EQ sliders. 

CAN-21706 Plug-in An issue has been resolved where VST AmbiDecoder did 
not receive any signal on output busses. 
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CAN-22088 Plug-in An issue has been resolved where ModMachines’s manual 
modulation mode took LFOs into account. 

CAN-21392 Plug-in 
Manager 

VST Plug-in Manager now allows Enabled/Disabled and 
Reactivate for multiple selected plug-ins at once. 

CAN-22168 Pool An issue has been resolved where dragging more than 
5000 files between folders in the pool could render the 
application unreliable. 

CAN-22252 Preferences An issue has been resolved where the Legato Mode: 
Between Selected Notes Only preference was not 
remembered. 

CAN-22421 Preferences An issue has been resolved where the Connect Sends 
Automatically for Each Newly Created Channel setting was 
not working correctly on group channels. 

CAN-21992 Process Bars An issue has been resolved where the Reinterpret Bars 
function did not work as expected. 

CAN-17775 Project Window An issue has been resolved where converting tracks from 
multi-mono to interleaved format resulted in incorrect track 
names. 

CAN-21361 Project Window An issue has been resolved where confirming the prompt 
to switch timeline to bars/beats could render the 
application unreliable. 

CAN-21921 Project Window An issue has been resolved where an automation track 
inside a closed folder could not be deselected when 
selecting a new track. 

CAN-22187 Project Window An issue has been resolved where replacing a track picture 
by dragging a file from the Finder could render the 
application unreliable (macOS only). 

CAN-22633 Project Window An issue has been resolved where opening the Auto Fade 
window could render the application unreliable. 

CAN-22568 Project Window An issue has been resolved where toggling Visibility Zones 
in the project window could render the application 
unreliable. 

CAN-22008 Project Window An issue has been resolved where Save and Save As key 
commands did not work when the HALion user interface 
was in front. 

CAN-17789 Remote Devices An issue has been resolved where Generic Remote 
commands could not access defined Insert plug-in slots. 



The image part with relationship ID rId2 was not found in the file.

 

Version History Page 6 Steinberg Media Technologies GmbH 

CAN-22378 Sample Editor An issue has been resolved where the Sample Editor Warp 
Marker changed to being nearly invisible. 

CAN-22728 Score Editor An issue has been resolved where switching Workspaces 
involving the Score Editor could render the application 
unreliable. 

CAN-21896 Score Editor Improved support of double dotted notes. 

CAN-17498 Stability An issue has been resolved where quitting Cubase with an 
open pop-up window could render the application 
unreliable. 

CAN-22221 Stability Improved stability when loading projects from earlier 
versions.  

CAN-22539 Stability An issue has been resolved where certain Track Archive 
files could render the application unreliable. 

CAN-22928 Stability An issue has been resolved where converting tracks while 
Automatic Hitpoint creation was active could render the 
application unreliable. 

CAN-22996 Stability An issue has been resolved where opening multiple 
Channel Settings could render the application unreliable. 
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Cubase 10.0.20 

Issues & Improvements  

Channel Settings window 

The window has been internally reworked to resolve issues such as truncated areas or 
enlarged faders. 

Direct Routing and Show Output Chain can be toggled in the Setup Window Layout menu. 
Other options have been removed. Please check and adapt your Workspaces when this 
window is included. 

The Always on Top option is now placed in the right-click menu of the Toolbar (or when 
clicking on the Set Up Toolbar button). 

Color handling additions 

Cubase 10.0.15 re-introduced the Color tool. Cubase 10.0.20 adds some more features 
to Color Handling. 

The previous Set up Colors... button in the Colorize pop-up has been moved to the Project 
> Project Colors Setup... menu 

You can manage your color set more easily in the Color Set tab: 

- Use the cog wheel icon to insert, duplicate, remove, and reset specific colors. 

- When you insert a color in between two other colors, the newly created color is a 
blend of these two, not plain white. 

In the Presets tab you can easily expand the default color set from 16 to 24 or 32 colors. 
You can also automatically add varying tints on the fly, without being forced to set up color 
shades on your own with a color picker. You can then decide how the colors should be 
sorted and use the New Color Set area to preview the result. 

Once you have changed the color set the application tries to match the current colors to 
the new ones, ensuring the coloring in your projects remains intact (as far as possible). 

All changes you make in the Project Colors Setup window can now be undone. 

The main new addition to the Options tab is the return of a preference to allow selecting 
colors with visible names. Once active, the Colorize pop-ups change to a menu list, 
showing colors and names together. 
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Context menu additions 

Additional commands have been added to the context menus within the project and editor 
windows. The most notable change is the inclusion of a Tools submenu. There is also now 
a context menu available in the Sample Editor and Audio Part Editor. 

Intensity parameter in hitpoint detection 

The hitpoints section in the Sample Editor now features a new Intensity parameter and 
allows you to filter hitpoints by additional characteristics beyond peak threshold. 

Depending on the audio material, one or the other will be more effective. However, a 
combination of both can help to get even difficult cases of selecting hitpoints under control. 
Working with threshold and/or intensity, both percussive and tonal material should benefit. 

Locator range duration 

This is a new item in the Transport Zone (and panel or toolbar) which shows you the 
duration between the left and right locator in the format of the current primary time display. 

You can also edit this value to adjust the locator range. The left locator position will remain 
the same and the right locator position is adjusted. 

Use a simple click on the button of the item to set Locators to Selection or a long click to 
quickly reverse the locators (see tooltip). 

Plug-in (G)UI updates 

The following plug-ins include updated graphics for high resolution displays. Some of them 
have had a complete redesign to continue the graphical rework of the plug-in set: 

- ModMachine 

- AmpSimulator 

- Magneto 

- Quadrafuzz v2 

- TubeCompressor 

- Vintage Compressor 

- VSTDynamics 

- REVelation 

- RoomWorks 

- MonoToStereo 

- Mix6to2 

- Tuner  
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Show notification when switching tool mode with key command 

You may have noticed that pressing a key command (e.g. 1 for the object selection tool) 
shows a yellow notification of your choice of sub tool. If you find it too distracting, you can 
switch off this notification in the preferences... > Editing > Tools section.  

Steinberg Library Manager support for Cubase content 

This update installs a new version of the Steinberg Library Manager, which is now able to 
manage not only HALion/Sonic/SE and Groove Agent/SE Content, but also other Cubase 
Audio and MIDI Loop content, including PadShop. 

Vertically zoom in/out on waveform 

The waveform zoom sliders in the Project Window, Sample Editor and Part Editor can now 
be operated via key commands. 

Dedicated zoom commands have been added to the Edit > Zoom menu and have the 
default assignment ALT/Option+G and ALT/Option+H. 

You can change the assignment in Edit > Key Commands... > Zoom.  

Apple T2 chip audio controller compatibility 

Recent Apple Mac computers ship with Apple’s T2 chip, which also provides an audio 
controller (it’s used when you select the Built-in Audio ASIO driver in the VST Audio 
System in Cubase). 

The architecture is different than in the audio controllers used before, so we had to modify 
our CoreAudio2ASIO component. 

In situations where you plug cables (e.g. headphones) in or out, port connections are now 
resolved automatically, so you should always have an output on either internal speakers or 
devices connected to the headphone jack. 

If you need to check details, open the Control Panel for the built-in audio device in the 
Studio Setup window. 

List of resolved issues 

The following list details resolved issues and improvements in this version.  
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ID # Area Issue 

CAN-18714 Editing An issue has been resolved where the draw tools did not 
work correctly, depending on the selected snap value.  

CAN-21137 Editing An issue has been resolved where changing tools while the 
Choose Event Color panel is open could render the 
application unreliable. 

CAN-18275 Expression 
Maps 

An issue has been resolved where the last Expression Map 
in the Expression Maps Setup window could not be 
reached when a certain amount of Maps were already 
present. 

CAN-20361 MIDI Plug-ins An issue has been resolved where involving the MIDI plug-
ins Arpache 5 and SX could render the application 
unreliable. 

CAN-12866 MediaBay An issue has been resolved where MediaBay related 
windows only showed up with a noticeable delay after 
each startup of the application (macOS only). 

CAN-19839 MixConsole An issue has been resolved where the settings of the 
Maximizer module of the Channel Strip were not correctly 
applied when using the Freeze function. 

CAN-20466 Plug-ins An issue has been resolved where a saved default preset 
was not applied when the plug-in was inserted via drag & 
drop from the MediaRack. 

CAN-21151 Plug-ins An issue has been resolved where bypassing plug-ins did 
not work correctly when plug-ins were inserted that do not 
support a native bypass mode. 

CAN-20568 ReWire An issue has been resolved where MIDI overdub 
recordings using other DAWs with ReWire introduced a 
noticeable additional latency. 

CAN-13042 Routing An issue has been resolved where re-enabling instrument 
tracks using instruments with multiple active outputs could 
lead to orphaned outputs. 

CAN-19984 Sampler Track An issue has been resolved where Monophonic mode was 
not correctly restored when loading a project. 

CAN-21043 Sampler Track An issue has been resolved where the value of the Filter 
Envelope Amount was truncated in the GUI. 
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CAN-20215 Score Editor An issue has been resolved where setting up the Score 
Editor as Default Editor could leave the application 
unreliable when the editor was supposed to open in the 
Lower Zone. 
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Cubase 10.0.15 

Issues & Improvements  

Color handling improvements 

The Color Tool is back and the following color handling improvements have been added: 

- The Color Tool can be selected from the toolbox and coexists with the Colorize 
Selected Track or Events item again. 

- Clicking events with this tool colors them with the last selected color. 

- You can quickly change to another color using the mouse scroll wheel button on the 
Color Tool button when the tool is selected. 

- The last selected color is indicated in the background of the tool button when the tool 
is active. 

- Clicking events with the Command/CTRL modifier key allows you to select another 
color first from the current palette. 

- Clicking events with the ALT/Option modifier key switches to a Color Sampler tool 
which picks up the color from a clicked event to set as the current selected color. 

- In the Color Panel use Use Track's Color to set events to the same color of the track 
they reside on. 

- Colorizing Tracks: On the track header you can now select a track color by clicking 
with any modifier key in the area showing the track type icon to open the Color Panel. 
Additionally, you can also use the mouse scroll wheel + any modifier key. 

List of resolved issues 

The following list details resolved issues and improvements in this version.  
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ID # Area Issue 

CAN-20183 Chord Pads An issue has been resolved where working with Chord 
Pads and the pattern player could render the application 
unreliable.  

CAN-19528 Editing Selecting tools (which have sub-tools) by key command 
now leads to a small hint appearing on the screen for an 
improved indication. 

CAN-18275 Editor An issue has been resolved where the background color of 
the (Project) Logical Editor was shown in white. 

CAN-19365 Editor An issue has been resolved where it was not possible to 
colorize events within the Part Editor. 

CAN-19490 Editor The maximum possible vertical height for the Lower Zone 
Editor has been increased. 

CAN-19798 Editor An issue has been resolved where incoming MIDI notes 
were not indicated in the left-side keyboard display of the 
Key Editor. 

CAN-20231 Editor An issue has been resolved where controller lanes 
disappeared when reducing the height of the Lower Zone 
Editor tab, but did not reappear when height was 
increased again. 

CAN-18754 Expression 
Maps 

An issue has been resolved where switching between 
different Expression Maps in the Expression Maps 
Inspector section would cause the text lines to overlap.  

CAN-18700 Import Several issues with preview controls in the file selector 
window for importing audio files have been resolved. 

CAN-17155 MIDI Plug-ins An issue has been resolved where the Step Designer MIDI 
plug-in was not correctly scaled when HiDPI was enabled. 

CAN-17669 MixConsole An issue has been resolved where text input fields for 
Channel Strip controls were truncated or misaligned.  

CAN-17910 MixConsole An issue has been resolved where the “Time” column in 
the MixConsole History tab was not properly restored with 
its last size and position. 
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CAN-18936 Persistency An issue has been resolved where MIDI send routings 
were set back to ‘Not connected’ for disabled MIDI tracks 
after saving and reloading a project.  

(Please note that , for already affected projects, 
connections will have to be set again). 

CAN-19665 Plug-ins An issue has been resolved where removing all unavailable 
plug-ins removed plug-ins from all plug-in collections in the 
Plug-in Manager. 

CAN-15449 Project Window An issue has been resolved where tracks (or channels) 
remained unexpectedly selected in various situations. 

CAN-19550 Project Window An issue has been resolved where the last used window 
layout was not restored correctly, but always showed the 
default layout (only affecting Cubase LE/AI/Elements). 

CAN-19603 Score Editor An issue has been resolved where printing scores could 
lead to artefacts in the print-out (Windows only). 

CAN-20200 Score Editor An issue has been resolved where the function Show 
Rhythmic Notation was not working. 

CAN-19760 Transport An issue has been resolved where the secondary time 
display was missing in the Transport Zone (only affecting 
Cubase LE/AI/Elements). 
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Cubase 10.0.10 

Issues & Improvements  

Window handling 

The update addresses issues related to window handling, especially in the context of using 
HiDPI-capable displays on Windows systems with multiple displays using different scaling 
settings in Windows. 

Workspaces 

The Workspaces feature now works more reliably on all platforms. 

Please note that the layout and size of the MixConsole windows will be reset to default, no 
matter how they were saved in your project files before. After adapting the MixConsole to 
your desired layout again and saving the project with this version, the layout will correctly 
be restored the next time you load this project. 

When your Workspaces contain MixConsole windows, it is recommended to update them: 

- Recall affected Workspace 

- Adapt the MixConsole layout 

- Update the Workspace 

List of resolved issues 

The following list details resolved issues and improvements in this version.  
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ID # Area Issue 

CAN-19221 Add Track The amount of Return key strokes required in order to 
create (nameable) tracks has been reduced. 

CAN-18704 Audio 
Alignment 

An issue has been resolved when using Audio Alignment 
on shared audio events (using Musical Mode or 
AudioWarp and crossfades) could render the application 
unreliable. 

CAN-19402 Audio Export 
Window 

An issue has been resolved where downsampling from 
project sample rate to file format sample rate could render 
the application unreliable. 

CAN-19590 Audio Export 
Window 

An issue has been resolved where it was not possible to 
open the path browser when clicking on the path field. 

CAN-19619 Audio Export 
Window 

An issue has been resolved where it was not possible to 
preselect a file name when choosing a file path. 

CAN-18738 Direct Offline 
Processing 

An issue has been resolved where audio data was not 
properly interchanged with RX Connect (IZotope 
RX6/RX7). 

CAN-18831 Direct Offline 
Processing 

An issue has been resolved where using time stretch 
without time correction enabled could lead to audible 
artefacts. 

CAN-17925 Expression 
Maps 

An issue has been resolved where articulation symbols 
collided with their text description in the menu when 
setting up Sound Slots (Windows only). 

CAN-19304 Expression 
Maps 

The Expression Maps selector in the Inspector has been 
changed from a menu to a pop-up selector, to improve the 
handling of large numbers of Expression Maps. 

CAN-19390 HiDPI An issue has been resolved where plug-in windows could 
appear truncated in a mixed multiple-display setup 
(Windows only). 

CAN-19285 MixConsole The zooming performance when enabling the equalizer 
curve display in the rack section has been improved. 

CAN-9422 Plug-ins An issue has been resolved where using stereo effects 
within VST Bass Amp on a stereo track with mono audio 
material resulted in mono output of the plug-in. 

CAN-18395 Plug-ins An issue has been resolved where using Add VST Plug-in 
Picture to Media Rack could create an image unrelated to 
the plug-in. 
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CAN-15009 Remote Devices An issue has been resolved when importing XML files to 
set up Quick Controls could render the application 
unreliable. 

CAN-18481 Sample Editor An issue has been resolved when the behavior of the Paste 
command changed from inserting audio data (extending 
the overall length) to replace audio data (overall length is 
retained). 

CAN-19230 Stability An issue has been resolved which could occur when Auto 
Track Color Mode was set to ‘Use Last Applied’ color in 
Preferences > Event Display > Tracks. 

CAN-18676 Stability An issue has been resolved when enabling/disabling the 
Control Room via key command (triggered from a remote 
control device) could render the application unreliable. 

CAN-19212 Stability An issue has been resolved when using the remote control 
app Cubase iC Pro could render the application unreliable. 

CAN-18713 Transport Panel An issue has been resolved where the Click & Count-In & 
Click Pattern item was missing in the Set up Transport 
section. 

CAN-18588 Transport The handling of accessing various transport time values via 
key command, when affected value field is not visible on 
screen, has been improved. 

CAN-16632 User Interface An issue has been resolved where pop-up menus 
appeared offset to the clicked GUI item (macOS only). 

CAN-19084 User Interface An issue has been resolved where panel descriptions were 
truncated, e.g. in recording mode panels, depending on 
the language used. 

 


